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Overview 

Welcome to the Akvelon Global Preview User Manual. With this guide, you 

can learn how to install, configure, and use Akvelon Global Preview for 

Microsoft Dynamics CRM 2011. 

 

Global Preview for Microsoft CRM 2011 is a custom module which includes 

two features: 

- Email Preview 

- Preview Pane. 

 

Email Preview allows you to work with your email quickly and effectively. 

Email Preview provides the ability to: 

 View email contents and attachments without opening the emails. 

 Spell-check emails. 

 Search for emails by subject, body, and regarding fields. 

 Organize emails multiple ways to increase efficiency. 

 Perform certain actions with your emails: Add to Queue, Set Regarding, Assign to, 

and others, right from the Email Preview window.  

 

Preview Pane allows you to view detailed information for any activity in one 

click, without opening any additional windows, and also to configure the 

preview pane in the way you like.  

Preview Pane provides the ability to: 

 View the content of any entity with one touch including custom entities. 

 View entity attributes and Notes. 

 Preview open and closed entities for selected contacts, accounts, or any other entity. 

 Preview open and closed entities for custom entities. 

 Select entities and entity attributes to preview. 
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Licensing 

Whether you are using Microsoft Dynamics CRM 2011 in your production, development, or test 

environment, you always need licenses.  

Each organization requires its own license for Global Preview. In a typical setup you have one 

single organization and only need one license. The license contains the organization name and 

you can only install the license on the organization with the specified name.  

If you use multiple organizations, each organization requires a separate Global Preview license. 

However, you only need licenses for the organizations using Global Preview. If you have a single 

CRM server with four organizations and you want to use Global Preview in two of them, then you 

need two licenses.  

Each organization license (except the trial one) contains a restricted number of client user 

licenses (CAL). Each user of an organization that uses Global Preview must have a valid license. 

If an organization has 100 users and 50 users have permissions to perform searches using 

Global Preview (see the Global Preview User Permissions section), you need at least 50 

Global Preview licenses, otherwise you will receive a license validation error.  

When adding new users to CRM, be sure to verify that Global Preview also has corresponding 

licenses for those new users. 

To request Global Preview licenses please contact product.sales@akvelon.com. 

mailto:product.sales@akvelon.com
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Installation 

Global Preview Installation if You Have Email Preview Installed 

During installation, Global Preview will install Email Preview by default – this may cause certain 

compatibility problems.  

So, if you already have Email Preview installed, you should deactivate and remove it before 

installing Global Preview + Email Preview: 

First deactivate Email Preview:  

1. Open your CRM web page – log on as a user with System Administrator privileges. 

2. Open Workplace > My Work > Email Preview. 

3. Press the About button. 

4. Press the Deactivate button in the License window that opens – wait until deactivation 

is completed. 

Then uninstall Email Preview: 

1. Open Control Panel > Programs > Programs and Features. 

2. Find Global Preview (Activity Preview is the old version) in the list of programs > select 

Global Preview.  

3. Press the Uninstall button – wait until the uninstall process completes. 

You can also check the Uninstall Global Preview section for additional information.  

 

After Email Preview is deactivated and uninstalled, you can start Global Preview installation (see 

the Global Preview Installation section). 

Please note: the license key for Email Preview cannot be used for Global Preview. Please 

contact us to get a new license key. 

Please note: We strongly recommend emptying the cache in the IE browser before working with 

Global Preview (see the Global Preview Installation section). 

mailto:gs.support@akvelon.com
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Global Preview Installation 

To set up Akvelon Global Preview on Microsoft Dynamics CRM, follow these steps: 

1. Log on to your Microsoft Dynamics CRM server using an account that has administrative 

privileges.  

2. Run GlobalPreview-x64.msi.  If  UAC  is  enabled,  right-click  on  the  setup file and  

select "Run as Administrator.”  

3. Follow the installation wizard.   

4. After installation, Global Preview should be activated. An activation window for the CRM 

server default organization will open after installation. If you need to activate Global 

Preview for a non-default organization you should open the activation page manually 

(see the Activation section for more details). 

5. Give search rights to users (see the Global Preview User Permissions section). 

 

Please note: In cases where Email Preview or Global Preview was previously installed on your 

computer, we strongly recommend clearing browser and Outlook cache before using the tool.  

 

Internet Explorer: Make sure you first close Outlook > Tools > Internet Options > Browsing 

history area > press Delete > select two check boxes > press Delete. 

 

Figure 1. Clear Browser Cache 
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Outlook 2010: open File tab > Options > select Advanced > press “Custom Forms…” > “Manage 

Forms…” > press “Clear Cache” > restart Outlook. 

Outlook 2007: click on Tools menu > Options > select “Other” tab > click on Advanced Options > 

press “Custom Forms…” > “Manage Forms…” > press “Clear Cache” > restart Outlook. 

Then: 

Close Outlook. 

Open C:\Users\<username>\AppData\Local\ Microsoft\FORMS > delete FRMCACHE.DAT 

Open C:\Users\<username>\AppData\Local\ Microsoft\Outlook > delete all files with .ost 

extension. 

Start Outlook. 

 

To quickly access these folders, copy, then paste the lines into the address bar of Windows 

Explorer:  

 

%USERPROFILE%\Local Settings\Application Data\Microsoft\Forms 

%USERPROFILE%\Local Settings\Application Data\Microsoft\Outlook 
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Activation  

Activate Global Preview separately for each organization.  

Please note: Only users with CRM System Administrator role can activate Global Preview. 

To activate Global Preview for an organization, open the following page in your browser (the 

activation page for the server default organization will open when the installation is complete):  

http(s)://CrmOrganizationAddress/ISV/Akvelon/Mail/Pages/Activator.aspx  

(For example:  http://tds.crmdemo.akvelon.net/ISV/Akvelon/Mail/Pages/Activator.aspx).  

On the activation page you will see the End User License Agreement. Please read and accept it 

using the checkbox, then click the Activate button.  Input your Global Preview license into the 

open license window (see Figure 2. License Window) and click OK.  

 

 
 

Figure 2. License Window 

After you click Ok, a message indicating that Global Preview is activated will appear. Now you 

can use Global Preview. 

http://tds.crmdemo.akvelon.net/ISV/Akvelon/Mail/Pages/Activator.aspx
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Updating License Data 

If you need to update license data (e.g. to replace a trial license with a commercial license or to 

update the number of users) go to Settings > Global Preview Settings, and click the About 

button at the upper right-hand corner. Then click the Update license button, input the new 

license data into the license textbox (see Figure 3. License Information Window) and click the 

Update license button.   

 

 
Figure 3. License Information Window 
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Global Preview Settings Backup/Restore 

All configuration settings for Global Preview are stored inside the CRM database and do not 

require additional backup.  

If you restore CRM from a backup to a new server you should install Global Preview (please see 

Installation section). All activation, license, and configuration data will be preserved. 
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Uninstall Global Preview 

To uninstall Global Preview, please follow these steps: 

1. Deactivate Global Preview for ALL CRM organizations that have it enabled. 

Please note: Only users with CRM System Administrator role can deactivate Global 

Preview. 

To deactivate Global Preview go to Settings > Global Preview Settings and click the About 

button at the upper right-hand corner. A window with license information will open (see Figure 

4. License Information Window).  Click the Deactivate button.  

 

Figure 4. License Information Window 

 

2. Uninstall Global Preview using the “Add/Remove Programs” utility in the Microsoft 

Windows Control Panel (name in programs list: “Global Preview”), or using the Global 

Preview installer.   
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Email Indexing  

After you have installed and activated Email Preview, you should perform email indexing. Email 

indexing will significantly speed up your search. 

For example, searching 10,000 emails may take 1- 5 minutes without indexing. It will take about 2 

seconds after email indexing is performed. 

To index emails (see Figure 5. Email Indexing): 

1. Go to Workplace > Email Preview 

2. Click the Settings button at the upper right-hand corner  

3. Press the Enable Email Index button 

 

Figure 5. Email Indexing 

Please Note: if the dialog window says that email indexing is enabled and completed 

even though you didn’t enable it for Email Preview, you should disable indexing and then 

enable it again, otherwise Email Preview search may work incorrectly.  

To do that:  

- Press the Disable Email Index button 

- wait until the index is disabled 

- press the Enable Email Index button  

4. Wait until emails are indexed. 

Please note:  

1. Only users with CRM System Administrator role can perform email indexing. 
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2. Email Indexing is performed in CRM Database for Subject, Body, and Regarding fields. 

3. SQL Server Agent must be running.  

4. Email Indexing can take from several minutes to several hours depending on the volume 

of emails in the system and their contents (about 1 hour for 10000 emails).  

5. After the Email Index is created, it will be updated every 15 minutes to ensure newly 

created emails are also indexed. 
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Working with Akvelon Global Preview 

Akvelon Global Preview includes two features: 

- Email Preview 

- Preview Pane 

You can find the detailed information about these features in Akvelon Email Preview and the 

sections below. 
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Akvelon Email Preview 

To use Email Preview, go to Workplace and click on the Email Preview icon (see Figure 6. 

Email Preview Link and Preview Pane).  

 

Figure 6. Email Preview Link and Preview Pane 

The Email Preview window includes the following areas (see Figure 6. Email Preview Link and 

Preview Pane): 

1. List of emails 

2. Preview pane 

3. Tool bar. 
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List of Emails 

This displays the list of emails created in the system. When an email is selected in the list, its 

body is displayed in the Preview pane. The pane’s header includes information about email 

properties (subject, to, cc, status, date of creation, priority) and a list of files attached. To open an 

attachment, just click on it.  

Email Preview displays 50 emails per page by default. If there are more than 50 emails, Email 

Preview will spread the emails out on separate pages. To navigate through them, click on the 

page links provided (see Figure 7. List of Emails). Users can change the number of emails 

displayed; to do that just click on the Show dropdown list at the bottom and select any of three 

options: 30, 50, or 100 emails per page. 

 

Figure 7. List of Emails 
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Arranging Emails 

Sorting 

By default Email Preview sorts emails by relevance, with the most relevant emails listed on top. 

To sort by a different condition, select a sorting condition by clicking on the Arrange By button 

and then select a sort order by clicking on the button to the right. 

You can sort emails by one of the following conditions: From, To, Subject, Regarding, Scheduled 

Start, Scheduled End, Created On, Actual Start, Actual End, Priority, Status. 

Filtering 

Email Preview allows users to narrow the number of emails in the List of Emails using filters.  

The following filters are available (see Figure 8. Filters): 

Filter Name Description 

Date Allows users to view emails created within a specified date range. 

View 
Depending on the option selected, allows users to work with all emails (“All Items” 

option) or emails created by the current user only (“My Items” option). 

Status Allows users to view only emails with the specified status. 

 

 

Figure 8. Filters 

For example, if you want to view emails which you created today and have not sent yet, select 

Date=“Today”, View=”My Items”, Status=”Draft”. Emails which match the filters will be displayed 

in the List of Emails.  

Please note: Filters can be used together with search. 

Tool Bar Functionality 

The Tool Bar allows you to perform the following actions: 
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Action Icon Description 

Print 
 

Select Print to print your email. Information about email properties 

(subject, to, cc, status, date of creation, priority) and a list of files 

attached will be included into the printout. 

Forward 
 

Select Forward to send an existing email to another recipient(s). The 

text of the previous email(s) and all attachments will be automatically 

included. 

Reply 
 

Select Reply to send a response email to the person who sent you the 

email. The text of the previous email(s) and all attachments will be 

automatically included. 

Reply All 
 

Select Reply All to send a response email to the person who sent you 

the email and also to everyone else who received the same email that 

you did. The text of the previous email(s) and all attachments will be 

automatically included. 

Create New 

Email  

Select Create New Email to create a new email. In cases where the 

user doesn’t have sufficient rights to create new emails, this button will 

be hidden. 

Delete Email 
 

Select Delete Email to delete an email. In cases where the user doesn’t 

have sufficient rights to delete emails, this button will be hidden. 

Refresh 
 

Select Refresh to reload the list of emails. 

Collaborate 
 

Press this button to perform standard actions that can be performed on 

entities in CRM. They are described in the table below. In cases where 

the user doesn’t have sufficient rights to perform all these actions, this 

button will be hidden. 

Settings  

Press this button to enable Email Indexing (see the Email Indexing 

section). In cases where the user doesn’t have sufficient rights to 

perform this action, an error message will appear. 

About  

Press this button to view the license information and update or disable 

the Email Preview license (see the Updating License Data section). In 

cases where the user doesn’t have sufficient rights to perform this 

action, an error message will appear. 

 

Collaborate functionality 

The Collaborate functionality includes the following actions: 

Action Icon Description 

Connect 
 

Select Connect to link an email to any other entity that exists in CRM: 

account, contact, opportunity, etc.  

Add to Queue 
 

Select this to add an email to the queue. 
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Assign 
 

Select Assign to change the owner of the email. The original user loses 

ownership of the email but automatically shares it with the new owner. 

Share 
 

Select Share to share an email with other CRM users or teams. When 

you share email with another user or team, you set which permissions 

that user/team will receive. 

Set 

Regarding  

Select this to fill in the Regarding field in an email. 

Copy a Link 
 

Select this to copy a link that will open the email in the clipboard. 

 

In cases where the user doesn’t have sufficient rights to execute all these actions, the 

corresponding buttons will be hidden. 
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Search 

Please note: before searching, verify that email indexing is enabled (see the Email Indexing 

section). 

 

Email Preview enables users to search for emails. Search is performed by Subject, Body, and 

Regarding fields. Email Preview performs case-insensitive searches using the word-beginning 

search principle. 

For example, if you type “hand” in the search text box you can find emails that contain “Hand”, 

“handicraft”, “HANDY”. 

To search: 

1. Type the search query into the search text box – the query should contain two or more 

characters.  

2. Press Search or hit Enter.  

Emails that match the search query will appear in the List of Emails. The first email in the list will 

be displayed in the Preview Pane by default. The matching text found in the emails will be 

highlighted in yellow (see Figure 9. Search). 

 

Figure 9. Search 

If filters were applied, only emails which match those filters will be shown. 

For example: 

If you search for “old” and the Date filter is set to “Today”, only today’s emails with “old” in the 

Subject, Body, or Regarding field will be shown. Yesterday’s emails with “old” won’t be displayed. 

To clear the results of the search, erase the text in the search text box and press Clear or hit 

Enter.  
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Please note: search is performed in all emails, but only a maximum of 450 matching emails will 

be displayed. 

 

Wildcard Search 

Wildcard Search is not available in this version of Email Preview. 

 

Multiple Words Search  

If several words are entered into the search text box, Email Preview will find all emails which 

contain those words in their Subject, Body, or Regarding fields. 

For example: 

If you type Jack London into the search text box, search will find emails which have Jack or 

London or both Jack and London in their Subject, Body, or Regarding fields.  

Search will find emails which have 

-  “London is the capital of Great Britain. And Jack lives there.”  

-  “Jack” in the subject and “London” in the body. 

- “Jack” in the Subject, Body, or Regarding field and no “London” anywhere. 

 

Please note: Multiple Words Search uses the “OR” principle. That means that every additional 

word in the search text box won’t increase the specificity of the search, instead it will increase the 

number of emails found. To make a search query more specific, use quotation marks (see the 

Search with Quotation Marks section). 

Search with Quotation Marks  

When you know that the email you are searching for contains some specific text, you can easily 

find it using search with quotation marks. 

For example: 

You know for sure that the email contains the phrase “wonderful. Evening” in the text. Type in 

these words as a search query using quotation marks – you cannot use dots, commas, or other 

punctuation marks: just “wonderful evening”. Search will find all emails which have this text in 

the Subject, Body or Regarding fields. 

 

Please note: matching text will be highlighted every time, except when either the search query or 

the matching text contains any punctuation marks or special symbols. 

 

 

 



 

Akvelon Global Preview User Manual 

 

 

©Akvelon, Inc. 2011, All rights reserved. 23 

 

You can also combine Search with Quotation Marks with Multiple Words Search. 

For example: 

You may enter “arranged the meeting” discuss or “arranged the meeting” “suns project” – 

in these cases each part of search query will be accepted as a separate “word” and a search will 

be performed using the “OR” principle.  

This search will find emails which have: 

- “arranged the meeting” in the email body and “suns project” in the subject 

- “arranged the meeting” in the subject and discussion in the body 

- or both search terms in the Subject, Body, or Regarding fields 

- as well as only one term, such as “arranged the meeting”. 
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Email Preview vs. Entities 

Email Preview gives users the ability to view and work with emails which belong to a specified 

entity: account, contact, company, opportunity, etc. To open the Email Preview workspace for a 

specified entity, open any of the existing records – account or contact – and click on the Email 

Preview icon in the Common list at the left – the icon appears in all entities marked as activities 

when you install Email Preview. The window that opens will contain all emails in which the 

selected entity was a sender, recipient, CC recipient, or BCC recipient (see Figure 10. Emails for 

Specified Entity). 

 

Figure 10. Emails for Specified Entity 

For example, you have a contact, “Jack Smith”, and when sending emails you selected him as a 

recipient twice, as a CC recipient five times, and as BCC recipient three times. So, if you open the 

record for “Jack Smith” and click on the Email Preview icon, you will see all ten emails concerning 

Jack Smith.   
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Spell Check 

Email Preview provides you with the ability to check spelling in the body of emails. 

To spell check, open any existing email or create a new one and press the “Spelling” button – 

Email Preview will begin spell checking. When an unknown word is found the Spell check dialog 

box will be displayed (see Figure 11. Spell Checking). 

 

Figure 11. Spell Checking 

The dialog suggests several options: 

Option Description 

Ignore Once 
Select Ignore Once to skip this occurrence of the unknown word without 

correcting it and continue spell checking. 

Ignore All 
Select Ignore All to skip the unknown word and all future occurrences of 

the word. This rule is applied for the current spell check session only. 

Change 

Select Change to change this occurrence of the unknown word and 

continue spell checking. You can type a word manually in the text field at 

the top or click on a word in the Suggestions list. 

Change All 

Select Change All to change both this occurrence and all future 

occurrences of the unknown word without prompting for confirmation. This 

rule is applied for the current spell check session only. 

Check grammar Select Check grammar to check grammar and punctuation in the text. 

Close Select Close to stop spell checking. 
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Please note: Corrections confirmed while spell checking will be applied after the spelling window 

is closed (either because spell check is finished or if you press the Close button to stop 

checking). 
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Preview Pane  

Preview Pane allows you to see the content and attributes of the selected entity.  

Preview Pane Locations 

Preview Pane is available in views and forms: 

1. In Views: 

- open any view on the Workplace, Sales, Marketing, or Service pages: Activities, 

Contacts, Accounts, Leads, Contracts, Opportunities, etc. 

- select any entity in the opened view – a preview pane for the entity will appear at the 

bottom (see Figure 12. Preview Pane). 

 

Figure 12. Preview Pane 

2. In Forms:  

- open any form (entity): Account, Contact, Opportunity, Lead, etc. 

- click on any item related to an opened entity in the menu at the left: Activities, Closed 

Activities, Sub-Accounts, Connections, etc.  

- select any entity in the window that opens – a preview pane will appear at the bottom 

(see Figure 13. Preview Pane in Forms) 
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Figure 13. Preview Pane in Forms 

Preview Pane is also available for custom entities. 
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Entities Available in Preview Pane  

By default, the following entities are available in the Preview Pane: 

- Accounts 

- Appointments 

- Cases 

- Contacts 

- E-mail Messages 

- Faxes 

- Leads 

- Letters 

- Notes 

- Opportunities 

- Phone Calls 

- Tasks 

Other entities, including newly created custom entities, are switched off by default, but they can 

be switched on in the Global Preview Settings area (for detailed information, see the Switching 

Preview Pane On/Off for Entities section). 
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Preview Pane Window 

The Preview Pane window contains two tabs:  

- General Tab – displays entity content and attributes. 

- Notes Tab – displays entity Notes information. The number shows how many notes the 

entity has (see Figure 14 Notes Tab). If the entity doesn’t have any notes, the Notes area will 

be empty and the Notes tab will have a “Notes (0)” label.  

 

Figure 14 Notes Tab 

If the entity doesn’t have a Notes area, the Notes tab will not be displayed (see Figure 15. Entity 

without Notes Tab). 

 

Figure 15. Entity without Notes Tab 

General Tab consists of three areas: 

- the header 

- the description area 

- the footer 

Entity attributes are displayed in the header and the footer. By default, there are four attributes in 

the header and four in the footer (see Figure 16. Entity Attributes).  
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Figure 16. Entity Attributes 

The attributes shown can also be changed or switched off – select “hidden” in the Global 

Preview Settings area (for detailed information, see the Configuring Entity Attributes section). 

Such attributes won’t be displayed on the preview pane (see Figure 17. Hidden Attributes, and 

compare that view with Figure 16. Entity Attributes). 

 

Figure 17. Hidden Attributes 

 

The Description area contains entity description information: text, links, pictures, etc. It also 

may contain formatted text or an html page. The description area can also be hidden (see Figure 

18. Description). 

 

Figure 18. Description 
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Users can tweak the Preview Pane Window size. To resize the Preview Pane Window, just drag 

the top border of the preview pane up or down.  

Please Note: if you changed the entity by adding or editing notes, updating email attachments, 

etc., press the Refresh button to update the Preview Pane (see Figure 19. Refresh Button).  

 

Figure 19. Refresh Button 
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Configuration 

This section describes how to configure the Global Preview roles, entities, and attributes 

displayed in the Preview Pane. 

Global Preview User Permissions 

To allow users to work with Global Preview, you must assign them special permissions:  

1. Go to Settings > Administration > Users.  

2. Select the user you want to provide with Global Preview permissions and press Manage 

Roles on the upper CRM menu.  

3. Add the user to the appropriate role: 

- assign the Akvelon Global Preview Administrators role to allow the user to change 

Global Preview settings (the user won’t be allowed to work with Email Preview or view 

the Preview Pane)  

- assign the Akvelon Global Preview Users role to allow the user to work with Email 

Preview and the Preview Pane. Access to Global Preview settings won’t be available for 

this user. 

4. After you assign a role, click the OK button (see Figure 20. User Roles).  

 

Figure 20. User Roles 
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Please note:  

1. Akvelon Global Preview Administrators and Akvelon Global Preview Users roles should 

have organization level privileges for Akvelon Mail Organization Settings and Akvelon Mail 

User Settings entities (see Figure 21. Akvelon Mail Privileges). 

 

Figure 21. Akvelon Mail Privileges 

 

2. The Akvelon Global Preview Administrators role provides the selected user with rights to 

manage THEIR OWN Settings.   

 

3. The Akvelon Global Preview Administrators role doesn’t provide the selected user with 

rights to Activate/Deactivate or Update the Global Preview license or with rights to enable/disable 

Email Indexing. One needs to have a “System Administrator” role to be allowed to do that.  

 

4. Akvelon Global Preview Administrators – doesn't influence number of Global Preview 

licenses.  Akvelon Global Preview Users – influences number of Global Preview licenses. 

For example: you purchased 10 Global Preview licenses, and you have 2 users with the 

Akvelon Global Preview Administrators role, and 4 users with the Akvelon Global Preview 

Users role – only 4 licenses are being used in this case. 6 licenses are available for 

additional Global Preview users. 
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Switching Preview Pane On/Off for Entities 

You can select entities to display the Preview Pane according to your business needs.  

To switch on/off Preview Pane for entities do the following (see Figure 22. Manage Entities): 

1. Open Settings > click on the Global Preview Settings.  

2. Press the Manage Entities button. 

3. In the Entities Manager dialog that opens: 

- check entities you want to display the Preview Pane (switch on) 

- uncheck entities you don’t want to display the Preview Plane (switch off). 

4. Press Ok.  

 

Figure 22. Manage Entities 

Custom Entities: If you added a custom entity and can’t find it in the Entities Manager dialog 

box – perform the deactivation/activation process to let Global Preview know about this new 

entity. 

 

To Switch Off (hide) Preview Pane for all entities (see Figure 23. Entity Name):  
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Figure 23. Entity Name 

1. In the Entities Manager dialog box: find the Entity Name check box. 

2. If the Entity Name check box is checked – uncheck it. 

3. If the Entity Name check box is not checked, but there are entities checked in the list – 

check the Entity Name check box so that all entities are selected, then uncheck it to 

switch off preview pane for all entities at once. 

4. Press Ok. 
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Configuring Entity Attributes 

You can select entity attributes and how many of them to display in the Preview Pane.   

To change/hide attributes to display do the following (see Figure 24. Entity Settings): 

1. Open Settings > click on Global Preview Settings. 

2. Double click on the entity to configure.  

3. In the Entities Manager dialog that opens: 

- select any field (attribute) from the dropdown list to change the entity attribute to display; 

- check the Hide checkbox to hide this attribute in the Preview Pane. 

4. Press Ok. 

 

Figure 24. Entity Settings 

Note: Global Preview won’t allow you to hide all fields (attributes) – at least one should be 

selected (see Figure 25. Hide All Fields). 

 

Figure 25. Hide All Fields 
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Save as Default Settings 

By default, Global Preview configurations that you set will be applied only to your user account, 

other users will have their own configurations. 

If you want your configurations to be applied to all CRM users you should press the Save as 

default button (see Figure 26. Save as default button). 

 

Figure 26. Save as default button 
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Troubleshooting 

Issue Solution 

When installing Global Preview, you get an error: “The source was 
not found, but some or all event logs could not be searched. To 
create the source, you need permission to real all event logs to 
make sure that the new source is unique. Inaccessible logs: 
Security.” 

Right click on GlobalPreview-
x64.msi and select 
Troubleshoot Compatibility 
item. Then press Start the 
program… button in the dialog 
appeared. 

Preview Pane doesn’t appear for a selected entity or appears with 
errors; when you click on buttons in Settings, they don’t work or 
errors appear.  

Verify you cleared the cache in 
Outlook and IE, see the Global 
Preview Installation section.  

Preview Pane doesn’t appear for a selected entity. Verify that this entity is selected 
in Global Preview Settings, see 
the Switching Preview Pane 
On/Off for Entities section.  

Preview Pane appears, but some fields are not displayed – there is 
empty space in their places. 

That may happen if the “Hide” 
check box is checked for those 
fields, see the Configuring 
Entity Attributes section. 

You configured your Global Preview Settings one way, but after a 
while your settings changed – and you didn’t change anything. 

That may happen if another 
user pressed the “Save as 
default” button and his/her 
configurations were applied to 
all users, see the Save as 
Default Settings section. 

Preview Pane is not displayed inside a custom entity form. You should deactivate and re-
activate Global Preview to 
make it “recognize” this new 
custom entity and show the 
Preview Pane for it.  

You selected multiple rows in the view, but Preview Pane is not 
displayed for them. 

Preview Pane is displayed for 
the first entity in the list of 
selected. Verify that the first 
entity is selected in Global 
Preview Settings, see the 
Switching Preview Pane 
On/Off for Entities section. 

You updated an Attachment or Note, but Preview Pane displays the 
old information. 

Press the refresh button to 
update Preview Pane. 

Preview Pane doesn’t appear when you click on an entity, and 
when you click on the Email Preview link, you see this error 
message: 

Verify you’ve assigned Global 
Preview roles to this user, see 
Global Preview User 
Permissions section. 
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You can work with Email Preview, but can’t view Preview Pane. 
When click Global Preview Settings link, you get “Insufficient 
privileges.” error. 

Verify Global Preview roles 
have organization level 
privileges for Akvelon Mail 
Organization Settings and 
Akvelon Mail User Settings 
entities. See Global Preview 
User Permissions section. 
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Feedback 

If you have any questions, experience problems, or have feedback – please feel free to contact 

us:  gs.support@akvelon.com. 
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